
RELEASE NOTES

Release Notes for Modo 11.1v1

Release Date

29 June 2017

System Requirements

Officially Supported Operating Systems

• Mac OS 10.10.x, 10.11.x, and 10.12.x (64-bit only)

• Windows 7, Windows 8, and Windows 10 (64-bit only)

• Linux 64-bit operating system (CentOS/RHEL 7+)

MinimumHardware Requirements

• Intel processor(s), Core i3 or higher

• 1 GB available hard disk space (for Modo installation).

• 6 GB available hard disk space (for full content).

• At least 4 GB RAM

• Display with 1920 x 1080 pixel resolution

• Internet connection for product activation and online videos access

• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of
graphics memory and drivers that support OpenGL 3.2 or higher.

Recommended SystemRequirements

NOTE: This information is our best recommendation for the average user. Requirements
vary by usage, and individual users may have different requirements from those listed here.

• 2.5+ GHz quad-core processor

• 250+ GB disk space available for caching and temporary files, SSD is preferable

• 16 GB RAM with additional virtual memory*
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• Display with 1920 x 1080 pixel resolution

• An NVIDIA or AMD graphics card with the latest drivers

• 2+ GB of graphics memory

• OpenGL 4.4 or higher support

*The use of virtual memory improves stability and helps prevent data loss on large projects.

TestedWorkstation Hardware

The configurations listed below are those that The Foundry have tested with Modo 11.0v1. Due to the
constantly changing nature and wide variety of computer hardware available in the market, The
Foundry is unable to officially certify hardware. The list below can be used as a recommendation and
does not guarantee that it meets your particular needs.

Please download and install the latest graphics driver from the NVIDIA or AMD websites. Make sure
that you are using 8.982.8.1 drivers or higher for AMD cards.

If you encounter any issues, please visit the Support Portal at https://support.foundry.com.

Tested Workstation Hardware

Apple

• MacPro4, 1

• MacPro5, 1

• iMac13, 2

• MacBookPro10, 1

Dell

• Dell T1700

• Dell T3610

• Dell T3620

• Dell T5810

• Dell T7610

• Dell T7910

• Dell Precision Rack 7910

• Dell Precision 5510

• Dell Precision 5520

• Dell Precision 7710

• Dell Precision 7720

• Dell M2800

• Dell M6800
HP • HP Z440
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Tested Workstation Hardware
• HP Z600

Tested GPU Hardware

AMD Prosumer Graphics Cards

• Radeon™ HD 1900 XT

• Radeon™ HD 2400 XT

• Radeon™ HD 2600 Pro

• Radeon™ HD 3870

AMD Enterprise Graphics Cards

• FirePro™ W4170

• FirePro™ W5000

• FirePro™ W8000

• FirePro™ W2100

• FirePro™ W5100

• FirePro™ W4100

• FirePro™ W7100

• FirePro™ W8100

• FirePro™ W9100

• Radeon Pro WX7100

• Radeon Pro WX5100

• Radeon Pro WX4100

NVIDIA Prosumer Graphics Cards

• Geforce GTX 680

• Geforce GTX Titan

• Geforce GT 650M

NVIDIA Enterprise Graphics Cards

• Quadro® K6000

• Quadro® K5000

• Quadro® K4000

• Quadro® K2000

• Quadro® K600

• Quadro® K5200

• Quadro® K4200

• Quadro® K2200

• Quadro® K1200

• Quadro® K620
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Tested GPU Hardware
• Quadro® M5000

• Quadro® M4000

NVIDIA Quadro Graphics Cards:

• P400

• P600

• P1000

• P4000

• P5000

New Features

Alembic I/O Improvements

Alembic Streaming Improvements

Modo can now stream in geometry using Alembic Streaming Deformers and Alembic Streaming
Meshes.

The Alembic Load Options dialog now has a Polymesh streaming optionsmenu, which allows you
to import geometry items and deformers into the current scene, enabling you to layout and render
very large animated Alembic files exported from Modo and other Digital Content Creation software
packages. In addition, particles, simulated meshes, curves, multiple UV sets, components of a mesh,
and materials are also imported into Modo.

Alembic Export Improvements

There have been multiple improvements made to the Alembic exporting functionality, which
complements the Alembic streaming improvements, to enable better workflows. Performance when
exporting scenes with many key frames, deep item hierarchies, and replicators has been significantly
improved.

The Alembic I/O option Include Unique Suffix In Item Names has been added to improve how item
names are handled by skipping unique suffixes enabling you to preserve your naming conventions
through the cycles of importing, modifying, and exporting Alembic files. The Force Letters and
Digits Only Item Names option has been added to assist you in filtering exported item names to
digits and characters, allowing better compatibility with Katana and Nuke.
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Advanced 3D Viewport Enhancements

Advanced 3D Viewport

Performance improvements have been made to the Advanced viewport to speed up the frame rate.

The Display OpenGL Preferences now includes an AVP Allow Material Texture storage option.
When enabled, it controls how the 3D Viewport stores its data internally in the textures or uniform
buffers.

In addition, the following 3D Viewport properties have been added to improve performance: 

• Shadows CSM - Sets the number of shadow buffer projections the Cascade Shadow Map system is
allowed to use for the light source, allowing you to view casting curved shadows on curved surfaces.

• Shadows Size - Sets the texture resolution used when depth projecting the shadows. The following
options are available: Low, Mid, and High. By default, this option is set to High.

• Shadows Filter - Sets whether the shadows are filtered. By default, this option is On.

• Material - Overrides the Shader Tree materials being used in the scene. This setting provides faster
rendering performance results in the Advanced Viewport when rendering a number of different
types of materials. These options are also useful when working with a Unity Material or Unreal
Material.

Auto-Save

Auto-Save Cancel Option

Auto-Save is now preceded by a 10 second countdown with an option to cancel. The Cancel button
and countdown appear in a small box on your current 3D Viewport. Pressing Cancel skips the current
Auto-Save and launches at the next regularly scheduled Auto-Save interval.

Auto-Save Incremental

You can now set a number of incremental Auto-Saves in the Preferences > Auto-Save options.
Consecutive auto-saves are now numbered and do not overwrite previous auto-save files. These file
versions are prefixed with the version number and new auto-saves shuffle all the older numbered
files down. For example, the most recent auto-save ofMyFile.lxo is renamed 1_MyFile.lxo, the
second most recent, 2_MyFile.lxo, and so on.

Release Notes for Modo 11.1v1 |



RELEASE NOTES
6

In addition, Auto-Save saves the current Preview rendered state, allowing you to pick up a
progressive render from its last saved point when you open an auto-saved scene, rather than having
to start the render again.

Direct Modeling

Topology Pen Improvements

The Topology Pen tool has a number of new options to improve the re-topology workflow. We have
added a newMode called Smoothing, several new Falloff options, new Smoothing options, and the
followingMiscellaneous options: Copy Discontinuous UVs and Keep Vertices.

Smooth Tool Improvements

The Smooth tool has new options to improve smoothing positions along boundary edges and corner
vertices. Lock Boundary, Lock Corner, Lock Sharp Edges, and Sharp Angle options have been
added. It is now available as a Procedural Mesh Operation.

Sculpt Smoothing Improvements

The Smooth mode of mesh sculpting is improved to maintain border edges and corner vertices of
border polygons. The Lock Corner option locks the vertex positions at corner vertex where the
valence is two or more.

Loop Slice Improvements

The Loop Slice tool now has a new option Select New Polygons. When enabled, this provides better
visibility to see the selected polygons. A guide color is displayed for the slicing edges of the selected
polygons.

Falloff Weight Tool

A new Falloff Weight Tool has been added, which creates a weight map and has similar functionality
as the Soft Selection Falloff tool. Using the weight map generated by the Falloff Weight Tool is very
useful for modeling, texturing, dynamics, rigging, and more.

Release Notes for Modo 11.1v1 |
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Convert Falloff Cache

We have added a new Convert Falloff Cache tool, which allows you to convert internal falloff weights
generated in Element Falloff and Soft Selection Falloff into a regular weight map. The internal
cache stores falloff weight values for the last operation with Element Falloff or Soft Selection
Falloff. This tool is enabled only when one of these tools is used on the active meshes.

File I/O

Setting, Loading, and Saving Scene Thumbnails

The Scene Item properties have two new options, Set Thumbnail and Load Thumbnail, enabling
you to take a snapshot of your current scene from the 3D Viewport, Preview Viewport, and the
Render Display and embed a thumbnail image into the LXO file.

Create Scene Templates and Load from the Preset Browser

You can now create a template scene by renaming any *.lxo scene file using the extension *.lxt and
load these scenes from the Preset Browser.

General Workflow Improvements

User Channels

The Modo now allows you drag and drop channels onto mesh items in your scene to turn them into
User channels.

GL Viewport Workflow Improvements

Disable GL Textures and GL Color Overrides

The Shader Item now includes aGL Display option to toggle on and off the display of textures in the
Camera View to improve readability and performance when working on complex scenes. In addition,
theMaterial item now has a new GL Override option. When enabled, [[[Undefined variable Modo_
Variables.Product]]] uses the defined GL Color values to change the color of specified polygons
displayed in the Camera View without affecting the rendering in the Preview Viewport. This is useful
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when working on complex models containing a number of parts, which you want to apply different
colors to.

3D Viewport Matcaps, UV Textures, and Environments

The 3D Viewport now has a Viewport Texturesmenu, allowing you to quickly select Environments,
Matcaps, and UV Textures to display in the 3D Viewport. The UV Textures are used for UV
Diagnostics. These changes do not affect the scene; they only change the viewport itself. This allows
you to quickly view your scene with a Viewport Texture without having to add them to the Shader
Tree.

Procedural Modeling

New Mesh Op - UV Create Operator

The UV Create tool works by projecting the polygons from a 3D space into the 2D (UV) space. The
basic operation is the same as the standard UV Create Toolbox tool. In this release, you have the
ability to create UVs using the procedural modeling process.

Square Option for Radial Sweep

The Radial Sweep tool now has a new Helix Generator Square option allowing you to align segments
along a square. The Radial Sweep tool is also available as a procedural mesh operation.

Smooth Mesh Operator Improvements

A new procedural Smooth operator has been added to improve smoothing positions along boundary
edges and corner vertices.

Rendering

Maximum Progressive Render Time

A newMax Render Time option has been added to the Progressive Rendering options to limit the
rendering time when saving a frame to a disk. This option is used by the Preview Viewport with the
default option settings enabled and with the Render Animation option enabled.
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Scripting the Preview Viewport

The Preview Viewport can now be scripted (run) from a command line usingModo CL. There are
now a number of new commands available to render a preview to an image, image sequence, and
movie.

Preview Convergence based on Primary Render Output

A new Convergence option has been added to the Preview Viewport. When enabled, Preview
checks that the image has converged to the minimum requirement (meaning the quality is good
enough) before rendering the next frame. Setting this value produces faster results.

Preview Full Resolution Zoom

Zoom functionality in the Preview Viewport has been improved. You can now zoom in for a closer
look without affecting the camera's position with a middle scroll wheel mouse. The view now snaps to
25%, 50%, 200%, 400% while scrolling your mouse button.

Unreal Bridge Plug-in

Server and Client Plug-in

Modo now has the ability to communicate with the Unreal Engine in real-time. To improve the
workflow for Game Engine users, you can use a network protocol to share data between Modo and
Unreal using the newModo Bridge plug-in. The connection between Modo and Unreal can be on the
same machine, across multiple machines on the LAN, or even possibly remotely. An entire scene or
selected elements from a scene can be pushed bi-directionally and updated between the Client and
Server. Mesh geometry, normals, UVs, textures, materials, as well as scene hierarchy, lights, and
cameras can be synchronized between both applications.

UV Tools

UV Coverage Indicator

A new UV Coverage value is displayed at the bottom right corner of the UV Editor, which shows the
amount of uniform UV space of the total region that is covered by geometry. This option is useful to
game workflows, when trying to maximize the amount of texture space being used for the target
surface. When you use a UV editing tools, the coverage is updated at the end of the editing process.
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UV Box Transform

A new UV Box Transform tool has been added, which allows you to quickly move around groups of
polygons in UV space. This tool, while active, draws a rectangular bounding box around the
component selection in UV space, to which you can apply transform actions.

Distortion Compensation

A new Distortion Compensation option has been added to reduce the distortion automatically to
produce cleaner UV maps. This is useful when working with primitives that do not have equal radius
values. The aspect ratio and related area size of UV polygons conforms to the 3D polygons. This
option as been added to the following primitives: Cube, Cylinder, Capsule, Sphere, Torus, and
Ellipsoid.

Split Command

A new Split tool has been added allowing you to split UVs along the selected geometry (along selected
edges, around polygon selection boundaries, or on vertices). It doesn't offset the UVs, but once split,
you can move the polygons independently.

Split and Sew

The Split and Sew tool is now more interactive. The tool now acts as a brush, with a radius. "Painting"
over vertices in UV space can split them apart, with the brush radius controlling how far they are
offset from their starting position. Holding a modifier key sews the edges together instead of splitting
them.

UV Tear Off Qualifier Key

Qualifier keys have been added to enable the Tear Off option to separate and move your selection of
polygons to a new position on your UV map. Holding down the Ctrl/Cmd + Shift keys, while dragging,
temporarily enables Tear Off mode.

UVs to SVG Real World Scale and Units

The Export UVs to SVG feature has been enhanced to give you better control over the real-world size
of your SVG output. This can be helpful both for creating templates to create UV-based textures in
external applications, and for applications like packaging or shoe creation, where a pattern with
accurate real-world dimensions must be created from a mesh's UVs.
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UV Relax Improvements

The Boundary option has been added to the UV Relax tool, which includes a number of options
used to relax boundary UV vertex positions, replacing the Lock Boundary and Straighten options
used in our previous release.

UV Overlapping Selection

A new Select Overlapping Polygons tool has been added to assist you in detecting errors with
UV mapped polygons. This tool provides three options to assist you in locating these errors - Cross
Intersection, Self Intersection, and Flipped.

Texel Density

A new Texel Density tool has been added to improve the Games workflow. This tool enables you to
quickly scale the size of UV islands or individual polygons such that they span roughly the same
number of texture pixels per meter of real size. This is useful when you are dealing with texture
density mismatches, in some cases you may either have differently sized UVs or textures, resulting in
visibly over-detailed or under-detailed areas relative to the rest of the asset or scene. Making the texel
density more uniform can help maintain a standardized level of texture detail across an asset or
environment.

New Default UV viewport Settings

The default viewport display settings to view UDIM Tiles on an UV map have been updated. The UV
viewport now shows a 0 to 1 space by default, instead of -1 to 1. The UDIM tile number display is
enabled by default, but it is only shown if more than the 0 to 1 space is shown.

Vertex Normal & Baking Improvements

Use Polygon Area Smoothing Option

A new Use Polygon Area option has been added to theMaterial item, which enables you to smooth
vertex normals to correct shading problems. Modo calculates the weight contribution of vertex
normals and averages that value by the polygon area. Use this option to improve smoothing and
shading for a mesh that has large polygon faces connected to small polygon faces. For example,
when there is a fine beveled face beside a big face.
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Vertex Illumination Baking Type and Output Options

The Vertex Illumination Baking tool has been renamed Vertex Shader Baking. In this release, new
Bake Type and Output Channel options have been added to this tool. Use these options to control
what Modo bakes and where it stores the result of the bake.

Object Space Normal Maps

To improve the Games workflow, we have added Object Normalmaps to encode the texture
direction in absolute terms in object space. This is typically used in games workflows for static, non-
deforming objects (environment, props, and so on) to quickly render in the game engines.

Baking Aids

Items now have a contextual menu for baking certain mesh features. A number of baking tools are
available in theMesh Operations list from the Bake contextual menu. From this menu, you can
bake occlusion, illumination, normals, displacements, texture effects, vertex shadings, vertex
curvatures, and bake to an Alembic file. The bake commands start a process of generating UVs,
packing them, doing a bake (through a bake item) and then save the resulting bake to an image that
can be added to the Shader Tree automatically.

Feature Enhancements
• Deformers: The Deformer > Slack Effector tool has been improved for deformations with
slackAmount set to 0%.

• Model: The Detriangulate tool has been added to the Geometry > Polygonsmenu.

• UI: The Texture Locator > Random Offset option called Surface was added for replicators.

• UI: A download URL is now provided when you have enabled the Update and Statistics >
Automatically Check for Updates option when a new version is available.

• SDK: SDK: Added Unreal & Unity material channels.

• SDK: TDSDK - Added the ability to cast to type-specific classes from amodo.Item, not just a
lx.object.Item.

• BUG ID 39501 - File Output: Alembic now supports exporting Locators.

• BUG ID 45959 - Model: The Loop Slice tool now draws sliced lines using a guide color.

• BUG ID 48383 - UV: The UV Vertex option was added to the UV Relax tool for merging UV islands .

• BUG ID 52242 - (Windows only) File Input: File > Load Audio file formats have been updated to only
list supported formats.
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• BUG ID 53434 - File Input: Improved Alembic mesh streaming to handle polygons with more than
four vertices.

• BUG ID 53735 - Documentation: The VDB Voxel topic has been updated.

• BUG ID 53824 - Documentation: The Inks tool topic has been updated to include Projection Ink
options.

• BUG ID 53951 - Documentation: The UV Transform topic procedures have been updated.

• BUG ID 54049 - Documentation: The Select Sliced Edges option has been added to the Axis Drill
and Curve Slice tool topics.

• BUG ID 54212 - Documentation: The Add Item, Add Deformer, and Add Mesh Operations Preset
Browser topics have been updated to include new procedures and UI changes.

• BUG ID 54888 - Documentation: Bezier Extrude Corner Radius option is now documented.

• BUG ID 55119 - Model: Modeling falloffs are now generating a user accessible falloff weight map.

• BUG ID 55186 - Topology: The Topology Pen > Copy Discontinuous UVs has been renamed Join
Discontinuous UVs.

• BUG ID 55656 - UI: The Update and Statistics dialog options have been set to Always.

Bug Fixes
• GL: Enabling Cache Deformers also enabled the Item Draw Cache.

• Model: Using the Topology Pen tool with theMode set to Smoothing and Slip UVs enabled caused
Modo to crash.

• Model: The Loop Slice tool sometimes caused Modo to crash.

• Sculpt: Sculpting in Modo sometimes caused Modo to crash.

• Sculpt: Interactivity on image based sculpting has been improved.

• UI: Toggling the visibility of the HUD in the 3D viewport caused Preview to crash.

• UV: Smoothing UVs caused Modo to crash.

• BUG ID 26699 - Model: Erratic Scale tool behavior occurred when using a tablet.

• BUG ID 34749 - File Output: Exporting replicated Subdivision surfaces to Alembic exported all
replicators, instead.

• BUG ID 35143 - Shader Tree: Multi-selected Gradient texture layers did not respect input parameter
changes.

• BUG ID 36896 - Animation: Excessive frame dropping and skipping occurred when animating an
enabled texture channel and while scrubbing in the timeline.

• BUG ID 41744 - File Output: Alembic exports failed when an MDD file was missing.

• BUG ID 42058 - File Input: Importing or referencing Alembic caches caused Modo to use more
memory and increased the file size.
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• BUG ID 43387 - Preview: When rendering all outputs, Modo displayed the incorrect Final Color
output.

• BUG ID 43683 - Dynamics: Dynamic Replicators did not follow the particle source of the replicator
that they were created from.

• BUG ID 45656 - Render: Texture Replicators rendered four times slower on frames when no
replicator particles were present in the frame.

• BUG ID 46062 - GL: Using Geometry > Freeze on selected sculpted geometry, which had a
displacement texture, caused displacements to double in size.

• BUG ID 46138 - File Output: Particles exported to Alembic did not import into Maya.

• BUG ID 47740 - File Input: You were not prompted to replace or find missing .csv cache files when
opening the file.

• BUG ID 47969 - Model: Reactivating Paste, when holding the Shift key, resulted in a double paste.

• BUG ID 48207 - File Input: Alembic deformers could not be dragged and dropped between scenes.

• BUG ID 48408 - File Output: Exported Alembic mesh items had identical names for transforms and
geometry.

• BUG ID 49285 - Render: Changing the start value of a render curve changed where the end of the
curve was drawn.

• BUG ID 50234 - Sculpt: Changing the Smooth Mode produced bad results for meshes that did not
use multi-resolution.

• BUG ID 51086 - UV: The handles on the Bend Tool did not point in the correction direction when UV
Symmetry was enabled.

• BUG ID 51273 - File Output: Modo became unresponsive when exporting an Alembic file containing
a full scene.

• BUG ID 51792 - Model: Setting the Item Instance > Parent option for theMirror tool did not work
as expected.

• BUG ID 51908 - Model: Setting any of theMesh Paint options under the Parent option, for example
Instance, had no effect.

• BUG ID 51915 - GL: The Advanced Viewport sometimes displayed jagged edges on shadows.

• BUG ID 51924 - Model: The Julienne tool > Angle Snap option did not work.

• BUG ID 51986 - File Input: Importing a stitched Alembic file containing animation rendered
incorrectly in Modo.

• BUG ID 52424 - Model: The Catmull-ClarkSubdivision Level could not be changed when merging
Catmull-Clark subdivisions into a mesh.

• BUG ID 52429 - Model: The Bezier Curve tool reacted unpredictably to edge selections.

• BUG ID 52436 - Model: Local axis did not work with multiple selections when aligned with global
axes.

• BUG ID 52504 - Model:Mesh Cleanup caused Modo to crash.
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• BUG ID 52527 - Render: Black dots (NaNs) appeared in the render output with replicated Catmull-
Clark subdivisions.

• BUG ID 52605 - File Input: 2D .dxf files did not import correctly.

• BUG ID 52633 - Shader Tree: Texture Replicators did not align to a specified Particle Source.

• BUG ID 53308 - Model: Polygon reduction (non-procedural) destroyed morph maps.

• BUG ID 53524 - File Output: Exporting a procedural animation to an Alembic file broke normals.

• BUG ID 53981 - Sculpt: It is not possible to select symmetry polygons after working with the Sculpt
Smooth tool and when creating morph maps.

• BUG ID 54004 - Replicators: The Curve Particle Generator tool and Replicators produced
incorrect results.

• BUG ID 54038 - File Output: Exporting an imported SolidWorks file as an .fbx formatted file caused
Modo to crash.

• BUG ID 54173 - Item List: Manipulating animation keys disabled the Delete key.

• BUG ID 54182 - Model: The Edge Slice tool, with theMulti Slice option enabled, sometimes created
bad geometry.

• BUG ID 54197 - File Output: Modo crashed when exporting Replicators to an .fbx file with grouped
prototypes.

• BUG ID 54251 - Model: In primitive creation mode, clicking on a translate handle, with Snapping
activated, did not constrain the movement to the specified axis.

• BUG ID 54258 - Model: The Edge Slide tool did not behave as expected when vertices were on top of
one another.

• BUG ID 54265 - Model: Symmetry failed to work in theWork Plane.

• BUG ID 54266 - File Output: Subdivision Weight did not export to FBX files correctly.

• BUG ID 54294 - File Input: Certain animated Alembic files did not render correctly.

• BUG ID 54333 - Model: The Curve Refinement Angle option for the Freeze mesh operator had no
effect on Textmesh operator.

• BUG ID 54339 - Topology: With the Topology Pen activated, using the Add Loop function (Shift +
MMB) to add an edge to a selection and then selecting any of the options below the Toolbox Mode
option, such as Edge Loop, canceled the loop selection.

• BUG ID 54367 - UV: A mesh item displayed vertices in the UV space but they did not display in the
Info and Statistics viewport.

• BUG ID 54401 - Model: The Detriangulate tool produced poor results.

• BUG ID 54557 - Functionality and stability problems were found when editing UVs of deformed
items and sometimes caused Modo to crash.

• BUG ID 54648 - Schematic: Tick appeared on the wrong item in the workspace dropdown menu.

• BUG ID 54695 - Deformers: The visibility icon for Transform Effector items in the Mesh Operations
list were missing.

Release Notes for Modo 11.1v1 |



RELEASE NOTES
16

• BUG ID 54713 - Preview: Enabling Final Render Quality in the Preview viewport did not override
the render settings (F9).

• BUG ID 54725 - Model: The Loop Slice tool did not distinguish points to merge based on the source
edge.

• BUG ID 54727 - Procedurals: The Add Mesh Operation Selection > Edge Boundary did not work as
expected.

• BUG ID 54741 - UI: After renaming a duplicated instance of a Locator and then right-clicking on that
item and selecting Change Type > Locator, the updated name was lost after saving and reloading
the scene.

• BUG ID 54803 - Render: The opacity of surfaces hit by shadow rays were not accounted for by the
material Use Refractive Index option.

• BUG ID 54804 - Model: Align Work Plane and Symmetry produced the wrong results.

• BUG ID 54832 - Paint: Paint Clone > Use View Projection was enabled by default.

• BUG ID 54834 - Model: Using the Axis Slice tool with theMode set to Size, and activating the gang
edit mode to change the Size X, Y, and Z values, flipped theMode back to Number.

• BUG ID 54852 - UV: Mirroring geometry broke attached vertices in UVs.

• BUG ID 54868 - UV: The Apply button was disabled for the UV Peeler tool.

• BUG ID 54869 - Shader Tree: Setting a texture layer effect to Bump sometimes caused Modo to
crash.

• BUG ID 54877 - File Input: The MDD reader did not close files.

• BUG ID 54896 - Model: The Axis Slice tool Hold Slice option did not work.

• BUG ID 54919 - Model: The Pen Tool > UV > Project To option did not allow you to select the U
Direction or V Direction.

• BUG ID 54922 - Model: Lasso selection did not select co-located vertex positions.

• BUG ID 54926 - Model: Using the Scale Tool with maximum tool handle size resulted in lagging
behavior.

• BUG ID 54928 - Model: The Dimension tool displayed incorrect values in Item selection mode.

• BUG ID 54930 - GL: Switching the kernel mode to CPU caused OpenCL initialization to fail while in
OpenSubdiv Drawing Override.

• BUG ID 54931 - (Mac OS only) Model: A rotated Work Plane displayed a um error for one of the
dimensions of the Dimensions tool.

• BUG ID 54933 - UI: Entering Play mode displayed error dialogs.

• BUG ID 54946 - Preview: Animation did not tessellate geometry per frame.

• BUG ID 54957 - Schematic: A Workspace selected, copied, and pasted to wrong workspace.

• BUG ID 54962 - Documentation: Ctrl+ Tab was the shortcut for the Layout Switcher but was
remapped to Tool HUD.
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• BUG ID 54979 - File Output: Exporting a scene to Alembic caused Modo to crash after all of the
virtual memory was consumed.

• BUG ID 54987 - UV: Setting values for the UV Relax tool produced NaN errors caused by zero length
edges.

• BUG ID 54996 - Render: Incorrect Indirect Caustics displayed in the scene.

• BUG ID 55000 - Model: The Radial Sweep > Square option only worked on the Y axis.

• BUG ID 55027 - UI: User config files were deleted when exiting Modo and were not backed up or
renamed to assist in investigations on why Modo failed.

• BUG ID 55040 - UI: Tooltips were missing for theWork Plane.

• BUG ID 55041 - UI: TheWork Plane button label did not update correctly when using a popover
form.

• BUG ID 55043 - Item List: Ctrl+Shift+drag created an instance of an instance instead of the source.

• BUG ID 55046 - UI: Applying Alt + click on theWork Plane button did not display the Optionsmenu
in several layouts.

• BUG ID 55047 - UI: The Selection Sets button was missing in several layouts.

• BUG ID 55050 - Model: Splitting a vertex that was shared by multiple open polylines caused Modo to
crash.

• BUG ID 55077 - UI: Maximizing and then minimizing the window changed a number of tabs in the
interface.

• BUG ID 55080 - Model: Inactive meshes were set to invisible and snapping still treated them as
visible.

• BUG ID 55087 - File Input: With Auto-Save disabled and Modo has crashed, you are presented with
a prompt to recover your saved file, which does not exist.

• BUG ID 55109 - UV: Using the Atlas 2 option in the UV Projection tool on multiple meshes
sometimes caused Modo to crash.

• BUG ID 55111 - Network Rendering: Aborting a render (on a slave system only) during the
preprocessing phase did not stop rendering on the slaves.

• BUG ID 55113 - Model: Selecting vertices from two point polygons (for some .dxf imports) and then
pressing P to create a polygon, created the polygon facing away, and sometimes regardless of
selection order (CW or CCW).

• BUG ID 55118 - File Input: Opening a scene and selecting No to locate a missing Alembic file caused
Modo to crash.

• BUG ID 55141 - Fusion: Incorrect triangulation of concave quads in MeshFusion procedural
displayed.

• BUG ID 55177 - UI: Several Work Plane preferences did not update when changing the Work Plane
state.

Release Notes for Modo 11.1v1 |



RELEASE NOTES
18

• BUG ID 55180 - Model: A customer mesh was destroyed when enabling Action Center > Local and
enabling the Align Radial tool.

• BUG ID 55189 - Model: Rotating elements when the handles were aligned to the screen axis did not
work.

• BUG ID 55193 - UV: Modo sometimes crashed when using the UV Relax >Mode > Adaptive and
Boundary > Straighten.

• BUG ID 55196 - Fusion: Adding an additional Fusion Slicer Assembly, for example Fusion Slicer
3Point.lxp, caused the original Fusion Item to disappear.

• BUG ID 55198 - Fusion: The trim subtraction operation sometimes trimmed beyond the bounds of
the Fusion source item.

• BUG ID 55203 - Fusion: The Fusion Slicer Assembly transform control did not work properly when
rotating the item.

• BUG ID 55206 - Sculpt: Bad pixels in Image-based sculpting created distorted UVs.

• BUG ID 55208 - Fusion: Moving a duplicated MeshFusion trimmed item caused Modo to crash.

• BUG ID 55211 - Preview: Toggling on or off a Light Material with Preview running sometimes
caused Modo to crash.

• BUG ID 55215 - File Output: Exporting to Alembic did not export the animation for a mesh, which
only had vertices.

• BUG ID 55225 - Documentation: An incorrect description was documented for the Render Output
called Surface ID.

• BUG ID 55230 - Procedurals: The Radial Sweep > Square option deformed an item when you
moved the center handle away from the middle Y axis.

• BUG ID 55234 - File Output: The game.export command was missing an argument to choose an
arbitrary file name for an .fbx file.

• BUG ID 55236 - UV: The UV viewport did not always update to display the latest selected baked
image in Shader Tree.

• BUG ID 55247 - UV: Resetting the UV Relax tool displayed an error message.

• BUG ID 55258 - UV: The UV Box Transform proportional constraint only worked with top-right
corner handle when holding the Shift key and dragging to constrain proportionally (lock U and V
stretch).

• BUG ID 55268 - UV: The UV tools had a duplicate dropdown menu for map selection.

• BUG ID 55296 - Model: Snapping a mesh to a component of an instanced mesh did not work when
its parent was hidden.

• BUG ID 55298 - Model: TheMesh Paint tool added multiple redundant materials.

• BUG ID 55305 - UI: Selecting New Scene from the Modo Introduction Screen did nothing.

• BUG ID 55313 - Model: Random crashes occurred when joining edges that included discontinuous
UVs.

• BUG ID 55318 - Fusion: Performance optimization altered the order of Fusion operations.
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• BUG ID 55321 - Item List: Memory corruption occurred when using Ctrl + Shift and dragging an
instance in the Item List.

• BUG ID 55331 - Schematic: With multiple workspaces, the selected workspace was not always
selected.

• BUG ID 55332 - Item List: Using the Item List > Select > Action > Group option created a Group
Locator before specifying a name for the group and could not be cancelled

• BUG ID 55339 - UI: Splitting the window in the UV viewport within Game Tools layout, using the
Shift + Ctrl + Tilde keys, did not allow you to remove the duplicated window.

• BUG ID 55357 - Rigging: Deform folders could not be re-ordered.

• BUG ID 55361 - Fur: Enabling the Fur material, GL Display> Bake GL Fur to Guides option caused
Modo to crash.

• BUG ID 55362 - UV: Reloading image maps did not update the UV viewport.

• BUG ID 55377 - Model: The Dimensions tool did not work in component selection mode when a
mesh contained Mesh Operations.

• BUG ID 55400 - Network Rendering: Network rendering for baking using Bake to Render Outputs,
caused Modo to crash on a slave machine.

• BUG ID 55406 - File Input: Importing Alembic files with the speed multiplier control set to 0.1 or
similar and then scrubbing in the timeline, did not show smooth animation playback.

• BUG ID 55416 - Render: The Render time estimate for a scene overview displayed Unknown.

• BUG ID 55431 - GL: Manipulating items containing lengthy animation caused significant frame rate
loss.

• BUG ID 55435 - File Output: Exporting to FBX did not preserve the parent naming convention.

• BUG ID 55459 - Model: The Drag Weld tool join discontinuous UVs option was not disabled by
default.

• BUG ID 55476 - GL: Item transform speed was slower compared to previous releases.

• BUG ID 55549 - UV: The Scale Tool in the UV viewport worked incorrectly when using a tablet.

• BUG ID 55563 - GL: Serious performance regression found.

• BUG ID 55566 - GL: Rotation of items or components in a camera view caused the initial movement
of the mouse cursor to jump.

• BUG ID 55637 - Preview: Setting the Preview Save Layered Image from the Options button caused
Modo to crash.

• BUG ID 55681 - Model: Using the Tack Tool on high density meshes caused Modo to crash.

• BUG ID 55714 - Documentation: The menu item noted in the Clone Tool topic incorrectly stated
Geometry > Create > Clone rather than Geometry > Duplicate > Clone.

• BUG ID 55715 - Paint: Trying to paint on an image used by a Backdrop item caused Modo to crash.

• BUG ID 55730 - GL: Performance reduced significantly when a Fur material Display Density option
was set to a value lower than the default value of 10.
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• BUG ID 55856 - Fusion: Removing the source mesh caused Modo to crash.

• BUG ID 55858 - Preview: The Final Render Quality option did not enableMotion Blur.

Known Issues and Workarounds Specific to Modo 11.1

This section covers known issues and gives workarounds for them, where appropriate.

Advanced Viewport

• BUG ID 50810 - Anisotropic texture filtering is lower quality than in the Default viewport.

• BUG ID 46995 - Ambient Occlusion display in the Advanced viewport is affected by selected item
wireframes.

You can disable Show Selection in the Visibility options or disable wireframe drawing on the active
mesh layers.

Animation

• BUG ID 53661 - Selecting actions does not always select the correct one. This is caused by copying
actions.

As a workaround, manually edit the tags on the broken actions by selecting them in the Groups tab,
then save and reload the scene.

Assemblies

• BUG ID 36452 - Assemblies exported from the Item List context menu result in poor visual layout of
nodes on import.

As a workaround, you can save assemblies from the Schematic viewport.

Baking

• BUG ID 50671 - Baking displacement maps can cause UV seams to be visible, and the baked
displacement map to show quilting effects and other render artifacts.

• BUG ID 49437 - The Bake Channel Swizzling option can’t bake to texture alpha.

Release Notes for Modo 11.1v1 |



RELEASE NOTES
21

Color Management

• BUG ID 49244 - (Windows only): With Perform Color Correction on, setting a default scene to a
scene with a mesh that has a position channel crashes Modo at launch.

As a workaround, use System > Reset Preferences to reset to defaults or move/remove the default
scene.

Default Viewport

• RGBA textures only draw correctly in the Advanced viewport. In the Default viewport, any
unsupported texture effect on an image map is drawn as diffuse color when the layer is selected in
the Shader Tree.

Deformers

• BUG ID 55470 - Freezing a mesh with normalized deformers and a Mesh Op caused Modo to crash.

File and Image I/O

• BUG ID 55439 - Alembic imported convex polygons with at least two close to co-linear edges may
not draw correctly in GL (appearing as missing triangles).

As a workaround: Import using the new Alembic Streaming options. Set the Polymesh streaming
options to Alembic Streaming Meshes (polys only, force all). Alternatively, select the base
material in the Shader Tree and enable Surface Normal > Double-sided, then change the
Smoothing angle to 180.

• BUG ID 50198 - Alembic scenes don't export some surface items, including static meshes and
procedural shatter items.

• BUG ID 49728 - Exporting selected layers (from the Item List context menu) to .fbx doesn't export
instances, unless the original mesh is also exported.

To resolve this, set the .fbx preference to Export Selection and use Export As….

• BUG ID 47036 - Color management in .svg images is not currently supported. This is a side-effect of
a bug fix where the largest allowable image size (64k x 64k) was always used when color correction
was enabled.

• BUG ID 46962 - Rendering .svg images used as stencil maps for displacement or for layer masking
can be very slow.
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Fur

• BUG ID 35731 - Fur length textures can’t be edited with the Stretch tool.

Use different fur length drivers, such as hair guides or vector vertex maps.

General

• BUG ID 49514 - Mac OS X only: Runningmodo_cl before running the UI Modo application breaks
code signing.

As a workaround, start the UI version of Modo once, before runningmodo_cl on any system where
you later intend to use the UI version.

GL

• BUG ID 55816 - Wireframes are washed out on transparent surfaces in the Advanced viewport.

As a workaround, avoid transparency when modeling or doing work where wireframes are needed.
Alternatively, use the Default viewport.

• BUG ID 55746 - Moving the mouse over a procedural mesh, when Animation > Enable Deformers
is off, may cause Modo to crash.

• BUG ID 55594 - Wireframe overlay is missing in orthographic views if Line Antialiasing is set to Full
in the Advanced viewport.

As a workaround, use the Line Antialiasing > System or Off option instead.

• BUG ID 55500 - Setting the Advanced viewport Effects >Material option to Basic displays Unreal
materials as white.

As a workaround, use Simple mode.

• BUG ID 55145 - Default viewport lights are not casting shadows in the Advanced Viewport.

• BUG ID 54456 - GL count is incorrect in certain circumstances, including when meshes are displayed
in wireframe mode or when displaying replicas.

• Windows only: Using Raptr can cause GL driver crashes in Modo.

Input Devices

• BUG ID 51741 - Mac OS X only: Modo sometimes becomes unresponsive when using the
combination of a click-drag in a tree view (for example, when toggling the visibility of two successive
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items in the Shader Tree), followed immediately by a two-finger scroll gesture on some devices,
including laptop trackpads and the Magic Mouse.

As a workaround, change to a 3-button mouse (recommended to fully access all of Modo's features).

• BUG ID 35856 - Linux only: Plugging in a Wacom tablet while Modo is running can cause undesired
movement. This cannot be fixed, due to a limitation of the hardware driver.

To avoid this, plug in the tablet before application startup or restart.

Item List

• BUG ID 53209 - Group creation (Ctrl + G) places the new group folder at a random position in the
Item List, if the items are not selected in a top down sequence.

As a workaround, select the items being grouped from top to bottom in the Item List before
grouping (Ctrl + G).

Modeling

• BUG ID Bug 55857 - Using theModel layout Toolbox Basic subtab Center Selected option on a
polygon selection, with multiple mesh layers selected, doesn’t center to the origin.

As a workaround, select only one mesh layer at a time or put all geometry in one layer.

• BUG ID 55842 - Using the Tack tool, with Align, Copy Geometry, andMake Bridge options enabled
may cause Modo to crash.

• BUG ID 32728 - Zooming out with a Space Navigator alters the Work Plane position.

Network Rendering

• BUG ID 48325 - Scenes with image sequences rendered with Full Frames use the wrong image
sequence number on slave machines.

As a workaround, use File > Consolidate Scene, then render the scene using a shared network
folder (Preferences option under Rendering > Network Rendering).

• BUG ID 36986 - Slaves render hidden meshes. Since mesh hide state is not stored in the scene,
when that scene is transferred to the slaves, the state is lost. The master respects the hidden state,
however.

As a workaround, if the intent is to avoid rendering, toggle the visibility for the item or render or
open System > Preferences > Rendering and disable Use Network Render Nodes.

• BUG ID 30318 - Network Rendering doesn’t support Realflow particles.
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• BUG ID 25636 - Frame passes are not supported.

• Several Bugs - While it apparently worked in Modo 902, in some cases, Network Rendering was not
implemented to support baking. Changes to Modo in the 10-series apparently broke what was
working for some artists, so the functionality has been disabled.

As a workaround, Modo 10 implemented the ability to Network Bake using Bake Items and an
external render controller. For more information, please see the SDK Wiki.

Node Shading

• BUG ID 50642 - Nodal shading does not support UDIMs.

Painting/Sculpting

• BUG ID 41682 - Textures are not always updating in Preview/Render when painting on an image
map.

You can save and reload the image to force the update.

Particles

• BUG ID 44551 - Surface Particle Generators may not update with changes to a Density Gradient
Input set to Slope.

As a workaround, choose Distance to Locator or any other setting from the Density Gradient
Input dropdown, then change it back to Slope.

• BUG ID 34925 - Re-opening scenes saved with large particle caches can cause problems.

To avoid such issues, delete the cache before closing Modo, or export the particles to .csv cache
files or Realflow .bin files. You can do this by attaching one of those nodes to the Particle Simulation
item in the Schematic viewport, and clicking Cache Simulation.

Preset Browser

• BUG ID 55882 - Pinning the Viewport Textures preset browser crashes Modo on restart.

As a workaround, run Modo in Safe Mode and select System > Reset Preferences or manually
delete the main config file.

Release Notes for Modo 11.1v1 |

http://modo.sdk.thefoundry.co.uk/wiki/Network_Rendering#Networking_baking_via_render_farm_controller


RELEASE NOTES
25

Presets

• BUG ID Bug 55867 - Dragging and dropping a preset material into a material group places the
preset above the Base Material, not in the group.

As a workaround, move the preset material group after dragging and dropping it.

Preview

• BUG ID 55901 - Preview is rendering images with the wrong color space for non EXR images.

• BUG ID 55646 - The Camera can’t be edited in Preview if any of its channels are locked.

• If a high poly mesh is not visible, the Preview baking output will be incorrect.

As a workaround, reset Preview to fix the baking.

Procedurals

• BUG ID 52149 - Curve Extrude mesh operation: The Path Segment Generator's Align to Normal
option doesn't work when using a Bezier with zero-length tangents.

As a workaround, rotate the polygons to point toward the +Z before extruding or make sure there
are no zero-length tangents.

• BUG ID 49767 - Scenes, which contain a UV constraint modifier driving texture properties, may fail
to load after saving, due to a modifier dependency loop.

• BUG ID 46512 - When rigged, Rock items and other procedurals do not display correctly in GL. This
is a limitation of the feature and will not be fixed.

You can use Preview or RayGL to visualize the variations from rigging.

Projections

• BUG ID 49473 - Projections are incorrect if the projecting camera is set to Vertical film fit mode and
the width is less than the height.

• BUG ID 43771 - Camera projections from non-render cameras show distortion in GL and baking.

To avoid this, make sure that the projection camera has a film width-to-height ratio that matches
the main render camera.

Release Notes for Modo 11.1v1 |



RELEASE NOTES
26

References

• BUG ID 44492 - If a scene that already contains references is referenced, the shading of the original
references may not persist.

As a workaround, limit scenes with shading to one level of reference.

• BUG ID 41119 - Reloading a reference after replacing it with the same file can cause Modo to crash.

Rendering

• BUG ID Bug 55787 - The Scratches procedural texture may produce NaNs in the Preview viewport
and Render Display.

• BUG ID Bug 55663 - Motion Blur applied on a curve in a Mesh Operation no longer works.

• BUG ID Bug 55262 - Displacement combined with normal maps renders incorrectly.

As a workaround, enable the Displacement as Bump option in the Render Item Settings or render
using Preview.

• BUG ID 53411 - Mesh lights or any direct light too close to a surface can produce fireflies (hot pixels)
in some cases.

As a workaround, use aMaximum Radiance higher than 1 W/srm2 to reduce the bias.

• BUG ID 53184 - Value presets created for material Subsurface Scattering samples in Modo 10.1 or
earlier now show on the render item instead.

• BUG ID 52730 - The Vertex Illumination Bake command doesn't work as expected, when the mesh
has transform channels.

As a workaround, freeze the transforms in the mesh properties.

• BUG ID 52011 - Tangent Basis handles Mirror UVs incorrectly.

As a workaround, apply Mikk or any other tangent space basis to the mesh before baking.

Rigging

• BUG ID 55059 - Binding can’t be used multiple times in Setupmode.

As a workaround, exit and re-enter Setupmode.

• BUG ID 27244 - Duplicating joints in a bound mesh retains influences from the original joint chain.
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Schematic

• BUG ID 55859 - Dragging and dropping a Texture Locator, Camera, or Light from the Shader Tree
into Schematic viewport doesn’t work.

As a workaround, with the item selected, click the Add Selected button in the Schematic viewport.

Scripting

• BUG ID 53458 - Right-clicking or running a script in the Script Editor can lock up input to Modo.

As a workaround, click in the top window of the Script Editor, use the main menus, or change to
another application, then switch back to Modo.

• BUG ID 55138 - Modo crashes when undoing a script which uses removeItems.

Sculpt

• BUG ID 55897 - Specular and shadows in the Default viewport stops showing when sculpting on a
displacement image.

As a workaround, use another viewport mode such as Advanced or Reflection, or apply aMatcap
shader to the Shader Tree.

Shader Tree

• BUG ID 37858 - In the Shader Tree, choosing a group from Add Layer > Image Map > (use clip
browser) fails.

To work around this issue, in the Clip Browser, choose a single image instead of the group, and
then change to the image group using the Texture Layer's Properties tab.

• BUG ID 30947 - Layer masking displacement does not work unless you drag and drop the masking
layer onto the displacement layer.

Topology

• BUG ID 55887 - In Remove mode, the Topology Pen doesn’t remove edges created by the Split
mode but instead removes the underlying polygon.
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Unreal and Unity Materials

• BUG ID 50701 - Unreal material Ambient Occlusion does not bake correctly in Modo.

• BUG ID 50700 - There is no way to visualize the Unreal SubSurface Color effect in Modo.

• BUG ID 50451 - On some graphics cards, Unity material may cause flickering in the Advanced
viewport when used with bump maps and shadows.

UI

• BUG ID 55759 - Transforming objects can cause the Items Properties panel to flicker.

• BUG ID 55702 - Mac OS X only: Saving layouts on certain multi-display configurations caused Modo
to crash.

As a workaround, having your primary display as the left-most, may prevent this.

• BUG ID 55571 - Resizing the dopesheet in Zen crashes Modo 11.1, but not in Modo 11.0.

• BUG ID 44496 - Mac OS X only: Disabling Affect System Color Dialog in Preferences > Rendering
> Color Management, and using the system color picker causes colors to darken with each use of
the color picker.

This is due to an OS X issue, which requires the color profile in both the monitor settings and color
picker to be set to sRGB IEC61966-2.1.

• BUG ID 44896 - Dragging and dropping an image from disk into the Clips list doesn’t work.

If the Clips list is empty, drop the image onto the bar at the top, otherwise drop it above or below
other images in the list.

• BUG ID 43162 (Windows only) -Setting a custom text size affects Modo's text drawing.

As a workaround, go to the compatibility settings by right-clicking the Modo shortcut or executable,
and turn off font-scaling for the application.

UV

• BUG ID 55891 - Show UDIM does not display the UDIM number in the UV viewport.

As a workaround, enable the Auto Spans option.

• BUG ID 55582 - The Tear-off modifier keys (Shift+ Ctrl) are live in the UV Transform tool, meaning
the Tear-off state changes during the drag if the keys aren’t held down.
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• BUG ID 55564 - The UV Distortion and UV Vertex maps are no longer accessible. This is due to bugs
and crashes with these ‘internal’ maps being visible to users. Modo 11.2 will introduce features to
replace prior uses of these maps.

Developer Notes
• BUG ID 55171 - Scripting: The polygon.getIsland() function enters an infinite loop in some
circumstances, which caused Modo to stop responding.

• BUG ID 54157 SDK: Documentation - Added a description for CLxValue StreamIO (class).

• BUG ID 54716 SDK: TDSDK (Mac OS only) - Fixed issue where Point IDs sometimes returned as Ints
rather than Longs.

• BUG ID 54863 SDK: Render Cache no longer crashes while working with multiple scenes.

• BUG ID 54998 SDK: Render Cache - Fur and Curve export are now working as expected.

• BUG ID 55103 SDK: Modo no longer crashes when batch processing many scenes.

• BUG ID 55176 SDK: Documentation - Command as Filter is now documented. For more information,
see Form Filtering.

• BUG ID 55194 SDK: TD SDK - Selection is now working as expected.

• BUG ID 55615 SDK: PlatformService.AppVersion() is now returning full version numbers (For
example, 1111, for 11.1v1).
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Release Notes for Modo 11.0v3

Release Date
12 May 2017

System Requirements

Officially Supported Operating Systems

• Mac OS 10.10.x, 10.11.x, and 10.12.x (64-bit only)

• Windows 7, Windows 8, and Windows 10 (64-bit only)

• Linux 64-bit operating system (CentOS/RHEL 7+)

MinimumHardware Requirements

• Intel processor(s), Core i3 or higher

• 1 GB available hard disk space (for Modo installation).

• 6 GB available hard disk space (for full content).

• At least 4 GB RAM

• Display with 1920 x 1080 pixel resolution

• Internet connection for product activation and online videos access

• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of
graphics memory and drivers that support OpenGL 3.2 or higher.

Recommended SystemRequirements

NOTE: This information is our best recommendation for the average user. Requirements
vary by usage, and individual users may have different requirements from those listed here.

• 2.5+ GHz quad-core processor

• 250+ GB disk space available for caching and temporary files, SSD is preferable

• 16 GB RAM with additional virtual memory*
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• Display with 1920 x 1080 pixel resolution

• An NVIDIA or AMD graphics card with the latest drivers

• 2+ GB of graphics memory

• OpenGL 4.4 or higher support

*The use of virtual memory improves stability and helps prevent data loss on large projects.

TestedWorkstation Hardware

The configurations listed below are those that The Foundry have tested with Modo 11.0v1. Due to the
constantly changing nature and wide variety of computer hardware available in the market, The
Foundry is unable to officially certify hardware. The list below can be used as a recommendation and
does not guarantee that it meets your particular needs.

Please download and install the latest graphics driver from the NVIDIA or AMD websites. Make sure
that you are using 8.982.8.1 drivers or higher for AMD cards.

If you encounter any issues, please visit the Support Portal at supportportal.thefoundry.co.uk.

Tested Workstation Hardware

Apple • MacPro4, 1

• MacPro5, 1

• iMac13, 2

• MacBookPro10, 1

Dell • Dell T1700

• Dell T3610

• Dell T3620

• Dell T5810

• Dell T7610

• Dell T7910

• Dell Precision Rack 7910

• Dell Precision 5510

• Dell Precision 5520

• Dell Precision 7710

• Dell Precision 7720
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Tested Workstation Hardware

• Dell M2800

• Dell M6800

HP • HP Z440

• HP Z600

Tested GPU Hardware

AMD Prosumer Graphics Cards • Radeon™ HD 1900 XT

• Radeon™ HD 2400 XT

• Radeon™ HD 2600 Pro

• Radeon™ HD 3870

AMD Enterprise Graphics Cards • FirePro™ W4170

• FirePro™ W5000

• FirePro™ W8000

• FirePro™ W2100

• FirePro™ W5100

• FirePro™ W4100

• FirePro™ W7100

• FirePro™ W8100

• FirePro™ W9100

• Radeon Pro WX7100

• Radeon Pro WX5100

• Radeon Pro WX4100

NVIDIA Prosumer Graphics Cards • Geforce GTX 680

• Geforce GTX Titan

• Geforce GT 650M

NVIDIA Enterprise Graphics Cards • Quadro® K6000

• Quadro® K5000
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Tested GPU Hardware

• Quadro® K4000

• Quadro® K2000

• Quadro® K600

• Quadro® K5200

• Quadro® K4200

• Quadro® K2200

• Quadro® K1200

• Quadro® K620

• Quadro® M5000

• Quadro® M4000

NVIDIA Quadro Graphics Cards: • P400

• P600

• P1000

• P4000

• P5000

New Features
There are no new features in this release.

Feature Enhancements
• BUG ID 55383 - Licensing: Upon notification of a soon-to-expire license, added the ability to show a
Run Modo button in the licensing dialog to allow users to continue to run Modo.

Bug Fixes
• BUG ID 55399 - Windows 10 only: Added a 24x24 pixel icon to improve the icon display in the
taskbar.
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Release Notes for Modo 11.0v2

Release Date
4 May 2017

System Requirements

Officially Supported Operating Systems

• Mac OS X 10.10.x, 10.11.x, and 10.12.x (64-bit only)

• Windows 7, Windows 8, and Windows 10 (64-bit only)

• Linux 64-bit operating system (CentOS/RHEL 7+)

MinimumHardware Requirements

• Intel processor(s), Core i3 or higher

• 1 GB available hard disk space (for Modo installation).

• 6 GB available hard disk space (for full content).

• At least 4 GB RAM

• Display with 1920 x 1080 pixel resolution

• Internet connection for product activation and online videos access

• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of
graphics memory and drivers that support OpenGL 3.2 or higher.

Recommended SystemRequirements

NOTE: This information is our best recommendation for the average user. Requirements
vary by usage, and individual users may have different requirements from those listed here.

• 2.5+ GHz quad-core processor

• 250+ GB disk space available for caching and temporary files, SSD is preferable

• 16 GB RAM with additional virtual memory*
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• Display with 1920 x 1080 pixel resolution

• An NVIDIA or AMD graphics card with the latest drivers

• 2+ GB of graphics memory

• OpenGL 4.4 or higher support

*The use of virtual memory improves stability and helps prevent data loss on large projects.

TestedWorkstation Hardware

The configurations listed below are those that The Foundry have tested with Modo 11.0v1. Due to the
constantly changing nature and wide variety of computer hardware available in the market, The
Foundry is unable to officially certify hardware. The list below can be used as a recommendation and
does not guarantee that it meets your particular needs.

Please download and install the latest graphics driver from the NVIDIA or AMD websites. Make sure
that you are using 8.982.8.1 drivers or higher for AMD cards.

If you encounter any issues, please visit the Support Portal at supportportal.thefoundry.co.uk.

Tested Workstation Hardware

Apple • MacPro4, 1

• MacPro5, 1

• iMac13, 2

• MacBookPro10, 1

Dell • Dell T1700

• Dell T3610

• Dell T3620

• Dell T5810

• Dell T7610

• Dell T7910

• Dell Precision Rack 7910

• Dell Precision 5510

• Dell Precision 5520

• Dell Precision 7710

• Dell Precision 7720
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Tested Workstation Hardware

• Dell M2800

• Dell M6800

HP • HP Z440

• HP Z600

Tested GPU Hardware

AMD Prosumer Graphics Cards • Radeon™ HD 1900 XT

• Radeon™ HD 2400 XT

• Radeon™ HD 2600 Pro

• Radeon™ HD 3870

AMD Enterprise Graphics Cards • FirePro™ W4170

• FirePro™ W5000

• FirePro™ W8000

• FirePro™ W2100

• FirePro™ W5100

• FirePro™ W4100

• FirePro™ W7100

• FirePro™ W8100

• FirePro™ W9100

• Radeon Pro WX7100

• Radeon Pro WX5100

• Radeon Pro WX4100

NVIDIA Prosumer Graphics Cards • Geforce GTX 680

• Geforce GTX Titan

• Geforce GT 650M

NVIDIA Enterprise Graphics Cards • Quadro® K6000

• Quadro® K5000
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Tested GPU Hardware

• Quadro® K4000

• Quadro® K2000

• Quadro® K600

• Quadro® K5200

• Quadro® K4200

• Quadro® K2200

• Quadro® K1200

• Quadro® K620

• Quadro® M5000

• Quadro® M4000

NVIDIA Quadro Graphics Cards: • P400

• P600

• P1000

• P4000

• P5000

New Features
There are no new features in this release.

Feature Enhancements
• BUG ID 55312 - Licensing: Added the ability to specify an optional proxy server for login-based
licensing from behind a firewall.

Bug Fixes
• BUG ID 55304 - Play Mode: Selecting Add Item in theMesh Operations list caused Modo to crash
when launched in Play Mode.

• BUG ID 55341 - UI: Launching Modo, on some systems, caused it to crash due to the Modo
Introduction screen.
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Release Notes for Modo 11.0v1

Release Date
20 April 2017

System Requirements

Officially Supported Operating Systems

• Mac OS X 10.10.x, 10.11.x, and 10.12.x (64-bit only)

• Windows 7, Windows 8, and Windows 10 (64-bit only)

• Linux 64-bit operating system (CentOS/RHEL 7+)

MinimumHardware Requirements

• Intel processor(s), Core i3 or higher

• 1 GB available hard disk space (for Modo installation).

• 6 GB available hard disk space (for full content).

• At least 4 GB RAM

• Display with 1920 x 1080 pixel resolution

• Internet connection for product activation and online videos access

• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of
graphics memory and drivers that support OpenGL 3.2 or higher.

Recommended SystemRequirements

NOTE: This information is our best recommendation for the average user. Requirements
vary by usage, and individual users may have different requirements from those listed here.

• 2.5+ GHz quad-core processor

• 250+ GB disk space available for caching and temporary files, SSD is preferable

• 16 GB RAM with additional virtual memory*
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• Display with 1920 x 1080 pixel resolution

• An NVIDIA or AMD graphics card with the latest drivers

• 2+ GB of graphics memory

• OpenGL 4.4 or higher support

*The use of virtual memory improves stability and helps prevent data loss on large projects.

TestedWorkstation Hardware

The configurations listed below are those that The Foundry have tested with Modo 11.0v1. Due to the
constantly changing nature and wide variety of computer hardware available in the market, The
Foundry is unable to officially certify hardware. The list below can be used as a recommendation and
does not guarantee that it meets your particular needs.

Please download and install the latest graphics driver from the NVIDIA or AMD websites. Make sure
that you are using 8.982.8.1 drivers or higher for AMD cards.

If you encounter any issues, please visit the Support Portal at supportportal.thefoundry.co.uk.

Tested Workstation Hardware

Apple • MacPro4, 1

• MacPro5, 1

• iMac13, 2

• MacBookPro10, 1

Dell • Dell T1700

• Dell T3610

• Dell T3620

• Dell T5810

• Dell T7610

• Dell T7910

• Dell Precision Rack 7910

• Dell Precision 5510

• Dell Precision 5520

• Dell Precision 7710

• Dell Precision 7720
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Tested Workstation Hardware

• Dell M2800

• Dell M6800

HP • HP Z440

• HP Z600

Tested GPU Hardware

AMD Prosumer Graphics Cards • Radeon™ HD 1900 XT

• Radeon™ HD 2400 XT

• Radeon™ HD 2600 Pro

• Radeon™ HD 3870

AMD Enterprise Graphics Cards • FirePro™ W4170

• FirePro™ W5000

• FirePro™ W8000

• FirePro™ W2100

• FirePro™ W5100

• FirePro™ W4100

• FirePro™ W7100

• FirePro™ W8100

• FirePro™ W9100

• Radeon Pro WX7100

• Radeon Pro WX5100

• Radeon Pro WX4100

NVIDIA Prosumer Graphics Cards • Geforce GTX 680

• Geforce GTX Titan

• Geforce GT 650M

NVIDIA Enterprise Graphics Cards • Quadro® K6000

• Quadro® K5000
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Tested GPU Hardware

• Quadro® K4000

• Quadro® K2000

• Quadro® K600

• Quadro® K5200

• Quadro® K4200

• Quadro® K2200

• Quadro® K1200

• Quadro® K620

• Quadro® M5000

• Quadro® M4000

NVIDIA Quadro Graphics Cards: • P400

• P600

• P1000

• P4000

• P5000

New Features

Games

Game Export Improvements

The Game Asset Exporter has been redesigned to make it more useful and easier to manage.

Progressive Baking Accessibility

Progressive Baking is now available from the menu bar, by clicking Render > Open Progressive
Baking.
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Unreal Material Importer Workflow Improvements

Some improvements have been made to the material importer workflow for Unreal, you can now:

• Import materials to any folder in Unreal Engine's Content Browser.

• Import textures into the texture sub-path, which can be specified in Modo's Game Asset Exporter.

• Import and update only selected materials in the Content Browser.

• Import and update only the materials that are used by selected meshes in the Content Browser.

• Assign materials to imported meshes, instead of instances in the scene.

• Use both theModo Material button and Unreal Engine 4's Import button to import materials.

Modeling

Auto Retopo Improvements

The following new options have been added to the Automatic Retopology tool:

• Shortest EdgePoly Scaling option

• CurvaturePoly Scaling option

• Adaptive Poly Countmode

• New Mesh option

Auto-activating Ghosting and Edit BaseMesh Command

Accessing the base mesh in procedural modeling has been simplified. When any base mesh is
selected, ghost mode is now automatically enabled. Secondly, the Edit Base Mesh command has
been added in the mesh options. This command directly sets up the editable base mesh mode for the
selected item.

Implicit Mesh Operation Selection

Items that are related to the sameMesh Operations list are now implicitly selected, so all their
properties are visible at the same time.

MeshFusionWorkflow Enhancements

The following improvements have been made to the MeshFusion workflow:
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• In-place Compound Trim creation and editing - a new workflow has been added for automating
the creation and editing of Compound Trims.

• Cut, Copy, Paste, and Split tools - new commands have been added for cutting, copying, pasting,
and splitting elements of a Fusion Item.

• Optimization Control - you can now optimize MeshFusion performance by either caching Boolean
operation, or by caching meshes.

Remove-Delete Keyboard Shortcuts

The keyboard shortcuts for deleting and removing components have been changed. The Delete and
Backspace keys delete components, while Shift+Backspace removes polygons. 

Sculpt Brush Preview

When a brush-based tool is activated, a circle is now drawn under the mouse when you hover over a
surface, to make painting and sculpting easier.

Select by Previous Operation

This new mesh operation allows you to select previously created elements in theMesh Operations
list.

Out of the Box Experience

Grid Display

A new panel has been added to specify Work Plane and grid display. You can click Work Plane > Grid
and Work Plane settings to open the panel.

Installation Streamlining

The following improvements have been made to the installation process:

• License dialog - the License dialog has been updated.

• Application name - Modo now installs using a proper Foundry naming convention.

• Start after install - the Windows installer now includes an option to start Modo after completing
the installation process.
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• Modo content - Modo now includes a core set of content. Basic sets of assemblies, aliases,
brushes, colors, matcaps, basic and sculpting meshes, profiles, paint and sculpt tools, and image
inks are provided. The Preset Browsers point to these core presets by default, where applicable,
while still providing access to external content.

• Start-up messages - the various start-up messages have been consolidated into one dialog.

• New version warning - when a new Modo version is available, a notification is displayed,
prompting you to download it. Clicking Yes in the dialog opens the
www.foundry.com/products/modo/download page.

Introduction Screen

The new introduction screen allows you to quickly open and create projects, and access learning
materials.

Motion Blur for Procedural Meshes

Procedural meshes now support motion blur. This allows procedural geometry that has been
generated by mesh operations, to appear blurred as the polygonal elements move through the
frame.

Preview Render Region Toolbar

A toolbar has been added to the Render tab to activate and set a render region in Preview, as well as
change the render camera.

SafeMode

To aid customer support in debugging issues, you can now run Modo without loading any kits, plug-
ins, or custom configurations.

Tool HUD

The Tool HUD, a context-sensitive form containing recently used tools, is available in the 3D viewport
for every layout. You can toggle its visibility by pressing Ctrl/Cmd+Tab.
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VDBVoxel Improvements

The following improvements have been made to the VDBVoxel item:

• Transform options - the VDBVoxel item now has Transform options in the Properties panel.

• Velocity Scale - velocity data can now be loaded if a voxel is created from particles that have
velocity information. Velocity Scale is used for scaling velocity data, by default it is set to 0, so as to
match the results in previous Modo versions. The value of velocity impacts generated voxels and the
generated mesh.

• Motion Blur - a scale value for motion blur, applicable to voxels created from particles that have
velocity information.

Performance and Efficiency

Backdrop Item Visibility

A Show in Perspective checkbox has been added to the Backdrop item properties, which enables
and disables the visibility of Backdrop items in the Perspective view.

Curve Particle Generator Improvements

The Curve Particle Generator's alignment has been improved and new End of Curve behaviors have
been added.

ItemDraw Cache

To speed up the display of items, several improvements to internal item drawing have been made,
especially in the cases of locators and animation. The animation display is now cached for every
frame for faster playback.

Faster Viewport Switching with Gradient

The speed of switching from the Default to the Advanced viewport has been improved.

Fur in the Advanced Viewport

With the fur material, fur can now be displayed as segmented lines in the Advanced viewport.
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GL Drawing Performance

The speed of drawing instance items, replica surfaces, and replica bounding boxes has been
improved.

Item List Improvements

The following improvements have been made to the Item List:

• Fast item hiding - you can now quickly hide and reveal items using the Alt+click and Shift+Alt+click
keyboard shortcuts.

• Select button - the Select button at the top of the Item List now allows you to select items using a
specific text pattern.

• Render camera icon - the render icon is displayed next to the render camera, and its name is bold.
You can now also set the render camera by right-clicking the camera in the Item List.

OpenSubdiv Drawing Package

The OSD drawing override now draws Pixar subdivision surfaces using OpenSubdiv 3.0 instead of
native Catmull-Clark and Subdivision polygon mesh drawing. This improves the drawing speed for
high subdivision levels.

Schematic Improvements

The following improvements have been made to the Schematic viewport:

• Node snapping - nodes are snapped into position when added to the Schematic.

• Instancing links - instances are highlighted in pink when you select their source item.

• Select Inputs - you can now select a node and all its incoming nodes by right-clicking the node,
then in the context-menu, clicking Select Inputs.

Selection Sets

• Selection set groups - you can now organize items using a specific selection set into a selection set
group.

• Selection set UI - selection sets have been made more accessible by adding a button to the modes
toolbar, which opens the Selection Sets panel.
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Spline and Bezier Deformer Improvements

Modo 11.0 adds an improved method for computing the setup of deformed transformation, to avoid
twisting problems. The following properties have also been added to the Spline and Bezier Effector's
properties:

• Draw Setup

• Align To Spline

• Anti-Twist Threshold

• Use Twist

• Use Scale

• Orbit Twist

Transform and Duplicate

You can now transform and duplicate components at the same time, holding Ctrl/Cmd+Shift when
using the Transform tools.

Rendering

Irradiance Caching Improvements

The following enhancements have been made to irradiance caching:

• Anisotropic irradiance values - cached irradiance values previously had circular regions of
influence based on their distance to the closest nearby surface. This meant that IC values tended to
be densely packed near inside edges such as between a wall and a ceiling. Now they can have
elliptical regions of influence, allowing them to be spaced further apart in the direction parallel to
an inside edge, potentially saving render time and memory.

• Store Direct Light option - this option is now enabled by default. It includes illumination from
direct light sources in addition to indirect illumination in the secondary irradiance cache values,
saving time whenever a first bounce indirect ray hits a surface that already has cached secondary
values.

MaximumRadiance

TheMaximum Radiance render setting has been changed into a unitless floating point number and
it acts as a multiplier for the most highly exposed render output in the scene.
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Mesh Light Improvements

The following enhancements have been made to mesh lights:

• Caustics - mesh lights and cylinder lights can now generate caustics like other direct light types.
Direct caustics need to be enabled in the Render Global Illumination settings, and caustics only
show in final renders, where photon tracing is calculated.

• Use Prototype Transform - this new option allows you to position a mesh light item's light by
positioning the prototype mesh item. This option is enabled by default, but scenes created in
previous versions still load with this option disabled.

Occlusion Baking Improvements

Occlusion rays fired from the base of the source surface no longer hit the back side of polygons by
default. In order for occlusion rays to hit the back side of surfaces, their materials need to be double-
sided.

Render Output Masking

Render outputs now support group masks and layer masks in the Shader Tree. 

Simplification of Render Settings

The render Properties tabs have been updated to use form proficiency levels to hide many of the
more advanced controls by default and allow focus on the most relevant options. In addition, the
render settings preset loader and camera picker are available on all three tabs.

Feature Enhancements
• Deformers: Most of the hidden channels for the Spline and Bezier Deformers have been moved into
the Properties panel.

• Windows only: Support for SolidWorks 2017 has been added.

• File Output: Games Export - Texture export paths have been fixed so they are no longer considered
absolute paths if prefixed by a forward slash.

• Network Rendering: We now pass frame buffers back from slaves for per-frame rendering.

• Render layout: The Material-level Importance control now also affects indirect (GI) and direct light
samples, which allows you to use it to control the overall quality of a specific material.
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• Render layout: An error message has been added for the render.dpi being disabled when not using
physical resolution units.

• Sculpt: A sculpt.constraint tool has been added to the Preset and Sculpt toolbar. In addition, the
Sculpt toolbar now has added labels on the dividers to allow collapsing of tools and settings.

• UI: An Add Loop tool has been added to the contextual pop-up menus and to the Tool HUD.

• UI: A progress monitor has been added to UV Atlas creation.

• BUG ID 37933 - Replicators: A Render Multiplier Radius option has been added to control the size
of the multiplication area.

• BUG ID 39414 - UI: Dynamics Soft Body tooltips have been updated.

• BUG ID 44623 - UI: For easy access, the Constraint Modifier and Procedural Shatter Dynamics
items have been added to the Setup layout Toolbox.

• BUG ID 46919 - Model layout: The Use Connectivity algorithm for the Soft Selection Falloff has
been improved.

• BUG ID 48433 - Preview: Un-premultiply support for saving Preview images has been added.

• BUG ID 49144 - UI: An option to auto-disable a backdrop item's visibility in non-orthogonal views
has been added.

• BUG ID 50490 - Dynamics: The Bezier Falloff and Spline Falloff dropdown menus now use user
names rather than internal names.

• BUG ID 50493 - Dynamics: Dynamic Item properties for the Sleep >Wake On > Force option is now
capitalized.

• BUG ID 52554 - Documentation: The Mirror topic has been updated to include more information
about setting theMirror Generator Mode to different Axis options.

• BUG ID - 52743 UI: Tooltips have been added to Particle Expression and other Particle modifiers.

• BUG ID 53234 - File Output: A confirmation dialog has been added to allow you to overwrite
previously exported .exr files using the same file name.

• BUG ID 53769 - Dynamics: The legacy option Particle Emit Group was removed from the UI.

• BUG ID 53841 - UI: A typo was corrected in Preferences > Defaults > Switcher Bar for Initially
Collapsed.

• BUG ID 54188 - Item List: A warning dialog has been added to alert you that you are about to delete
filtered texture locators.

• BUG ID 54236 - Dynamics: Margins for Dynamic Replicators are now locked to the value at the
beginning of a simulation. Rigid Bodies that share a common collision shape can't have different
margins. This prevents Modo from crashing when changing the margin value while simulating.

• BUG ID 54520 - Model layout: The auto-activate in tool presets has been enabled for the following
tools: Bevel (vert,edge,poly), Extrude (vert,edge,poly), Slice (edge,poly), uv.peeler, uv.relax, uv.create,
poly.sweep, poly.loopslice, Dicer, and Julienne.
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• BUG ID 54897 - Particles: We have removed theWake on Particle option from the Dynamic Item
properties.

Bug Fixes
• BUG ID Render layout: Primary rays were clamped when changing ray clamping values (maximum
radiance).

• BUG ID Render layout:  Occlusion rays hit the backside of single-sided polygons.

• BUG ID 15714 - Model layout: Running the vert.join command created corrupted UVs.

• BUG ID 24638 - UV: Switching to the UV viewport, when working with large image maps, caused
Modo to perform slowly.

• BUG ID 24733 - Sculpting layout: Changing theMultires palette option from high to low subdivision
levels caused responsiveness issues.

• BUG ID 28257 - Deformers: The Spline Deformer did not work as expected in some scenes.

• BUG ID 29723 - Model layout: Pressing Ctrl+Z to reactivate the Solid Sketch tool, with Snapping
activated and the Snapping Mode set to Vertex and the Constraint Mode set to Background
caused Modo to crash.

• BUG ID 30034 - GL: Undoing the hide selected command (keystroke H), while in Items selection
mode, did not work as expected.

• BUG ID 34400 - UI: Pressing O, to expand the active viewport to fill the entire local frame, did not
work correctly in some viewports.

• BUG ID 37467 - Model layout: PSUBs did not subdivide polygons correctly for some geometry.

• BUG ID 40486 - Model layout: Editing the final point of the Bezier path generator curve left one of
the Bezier node's handles behind.

• BUG ID 40639 - Dynamics: Dynamics Constraints properties for Body A and Body B options did not
work correctly.

• BUG ID 41976 - Shader Tree: Deleting multiple image map instances deleted the original texture
locator.

• BUG ID 42901 - Deformers: The Spline Deformer deformations did not pass cleanly to Locators.

• BUG ID 42982 - Deformers: Channels for the Move tool with custom handles were not automatically
selected.

• BUG ID 43220 - GL: Replicated items were not visible in the OpenGL viewport from certain Camera
or Perspective view angles.

• BUG ID 43388 - Preview: Outputs in disabled group masks rendered.

• BUG ID 43640 - UI: The Spline Effector visibility toggle button did not function as expected.

• BUG ID 43679 - Preview: Changing Render Output values restarted Preview.

• BUG ID 43976 - Dynamics: Dynamic Replicators sometimes froze when they hadn't stopped moving.
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• BUG ID 44092 - Scripting: Script errors occurred when running lx.eval("item.tag string DESC ?")
with more than 2047 characters.

• BUG ID 44501 - Model layout: The Spline Effector and Bezier Effector tools did not work with 1-
segment source/target.

• BUG ID 44763 - File Output: Canceling Export as tiled EXR to... didn't quit the command
immediately.

• BUG ID 45086 - Render: Using an imported SVG to drive displacement with IC enabled resulted in
the render hanging.

• BUG ID 45637 - Deformers: Some polygons in a Mesh item were collapsed by the Spline Effector.

• BUG ID 45847 - Volumes: VDBVoxel motion blur was oriented incorrectly.

• BUG ID 46046 - Deformers: Bezier node handles appeared incorrectly when ignoretransform
channel was set to True.

• BUG ID 46499 - Windows only: Autosave changed focus back to Modo when working in another
application.

• BUG ID 47548 - Dynamics: Applying a Procedural Shatter to an Active Rigid Body object with an
applied force didn't work as expected.

• BUG ID 48385 - UI: Clicking on a tool from a popover and then clicking in the 3D viewport did not
activate the tool.

• BUG ID 48625 - Render: Vertex Irradiance Caching displayed artifacts.

• BUG ID 49141 - File Input: Alembic particles didn't provide Particle ID information.

• BUG ID 49145 - Deformers: Creating a loop using a Bezier Effector deformed incorrectly and caused
kinks in the mesh.

• BUG ID 49433 - Procedurals: Weights were not propagated to new vertices created by the Polygon
Bevelmesh operation.

• BUG ID 49516 - UI: Lines sometimes appeared under form labels.

• BUG ID 49683 - Model layout: Resolution was lost around the root point using the Tube primitive
with Closed box and By Length options enabled.

• BUG ID 49814 - Render: Large material roughness values sometimes created invalid Fresnel
calculations and caused Modo to crash.

• BUG ID 49871 - UI: The UV View window could not be maximized in the Game Tools layout.

• BUG ID 49965 - UV: Modifying vertices in the UV Editor caused Modo to crash.

• BUG ID 50189 - UI: Changing the brush size with the right mouse button caused panels to redraw
with the Mesh Paint tool, including the Mesh Preset window.

• BUG ID 50364 - GL: The Advanced viewport showed visible seams and noise after turning off
environment textures.

• BUG ID 50486 - If a mesh had a deformer affecting it, you could not deselect elements using lasso or
Ctrl/Cmd+paint with your mouse.
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• BUG ID 50820 - UI: Headers or dividers in the Color Picker Color tab didn't collapse.

• BUG ID 50970 - File Output: Exporting frozen surface generator particles in Alembic format failed.

• BUG ID 51061 - UI: Adding Utility > Bake Wizard as a new tab in the right pane caused Modo to
crash.

• BUG ID 51179 - Procedurals: Polygon artifacts were created using the UV Transform mesh
operation.

• BUG ID 51228 - UV: The vert.join command sometimes merged discontinuous UV vertices
incorrectly.

• BUG ID 51339 - GL: The 3D viewport did not update when disabling masks containing a
displacement.

• BUG ID 51369 - GL: Loading a specific preset with Replicators turned the viewport yellow and
reported an error.

• BUG ID 51640 - File Output: Autosave and scene close failed with unsaved UDIM images.

• BUG ID 52093 - Deformers: Disabling a Spline Effector and then enabling a Bezier Effector did not
update the scene.

• BUG ID 52225 - Shader Tree: Duplicating an instance did not create a duplicate, it created an
instance of an instance.

• BUG ID 52261 - File Output: Consolidating clips to a tiled EXR function reset the UDIM numbers on
all clip items.

• BUG ID 52337 - Shader Tree: Using Add Layer > Group when either the Light or Environment items
were selected did not create the group under the Render item.

• BUG ID 52456 - Particles: The Spacing Distance for a Curve Particle Generator did not generate a
regular pattern as expected.

• BUG ID 52527 - Render: Black dots (NaNs) appeared in the Render viewport with replicated Catmull-
Clark SubDs.

• BUG ID 52553 - Render: Light sources with negative intensity values were clipped badly into black.

• BUG ID 52587 - UI: Adding a plug-in to many servers caused a stack overflow in
CompStandardMessageCompose.

• BUG ID 52654 - Procedurals: Setting Size of an axis to 0 for a Cube mesh operation resulted in a
random direction of polygon surfaces.

• BUG ID 52801 - Shader Tree: Right-clicking on aMesh Ops item, to remove it, deleted a previously
selected Material item instead.

• BUG ID 52841 - Procedurals: The Clone mesh operation did not work correctly when the source was
connected.

• BUG ID 52886 - GL: Draw Faded Grid did not work when the Preferences > Input > Units >
Coordinate System > Up Axis option was set to X or Z.
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• BUG ID 52891 - Network: Rendering progress did not correctly update in the lower pane of the
Render window, when network rendering by frames with slaves only.

• BUG ID 53088 - GL: Independent drawing did not work in the Default and Advanced viewports.

• BUG ID 53151 - Render: Saving passes as images sometimes saved the wrong alpha when the scene
only had alpha outputs in material masks.

• BUG ID 53182 - GL: The faded grid colors of the axis in the 3D viewport were incorrect when
switching from Advanced to Default.

• BUG ID 53209 - Item List: Creating a Group randomly positioned the folder in the Item List.

• BUG ID 53224 - Schematic: Assembly and Alias vector channels did not show gang edit properties.

• BUG ID 53225 - Network: Render progress was not displayed at the top of the Render window, when
rendering on a network by frames with slaves only.

• BUG ID 53254 - Model layout: Major performance problems occurred when working on specific
groups of polygons in a large complex mesh.

• BUG ID 53283 - Dynamics: Selecting options from the Geometry >Mesh Shatter menu caused
Modo to crash.

• BUG ID 53324 - Procedurals: Applying the Freeze mesh operation to Bezier text left extra vertices.

• BUG ID 53326 - Schematic: Aliases could not be dragged into the Schematic viewport.

• BUG ID 53333 - UV: Using the Transform tools with the Element action center in the UV Editor did
not work as expected.

• BUG ID 53356 - Particles: VDBVoxel items created from particles did not update when the particles
were changed.

• BUG ID 53398 - UI: All selected layers did not update when toggling visibility (eye icon) in the Clips
tab.

• BUG ID 53424 - Model layout: Focus did not work with Morph targets when Deformers were
enabled.

• BUG ID 53446 - UI: Highlighted areas on the Properties panel, during mouse over, sometimes
remained highlighted after moving the mouse away.

• BUG ID 53460 - Deformers: Selection Operators were added to the bottom of the graph list when
added through the Deformers list.

• BUG ID 53476 - File Output: Two UV sets on a single mesh were not applied correctly to an exported
Unity mesh.

• BUG ID 53488 - Render layout:  Changing the Target Color in the Render Window Image
Processing tab reverted the color back to white.

• BUG ID 53498 - Mac OS X only: Export Selected Layers caused Modo to crash.

• BUG ID 53503 - Scripting: Disconnecting graph connections using the bitshift-operator (<<) caused
an error.

• BUG ID 53542 - Presets: The Scatter Clone tool sometimes crashed when selecting another Preset.
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• BUG ID 53565 - Procedurals: Memory was not released after deleting a VDBvoxel item used by a
Merge Meshes operation.

• BUG ID 53588 - UI: Overwriting 3D viewport presets caused Modo to crash.

• BUG ID 53603 - Item List: item.duplicate default settings changed based on the last time it was
called.

• BUG ID 53624 - Network Rendering: Image processing was not possible with offloaded rendering on
a network render, using slaves only.

• BUG ID 53625 - Paint: The Fill and Smudge buttons didn't appear as active (orange) when clicked.

• BUG ID 53713 - Scripting: Several vertex and polygon properties returned values from the wrong
components.

• BUG ID 53716 - GL: Onion Skinning did not work in the Advanced viewport.

• BUG ID 53737 - Volumes: Reverting a scene, after running the scene containing a VDBvoxel item in
the Preview, caused Modo to crash.

• BUG ID 53741 - Scripting: Querying edge selection resulted in a MeshEdges object had no attribute _
mesherror.

• BUG ID 53742 - UI: Changing the System > Preferences > Input > Drop Mappings option to
Viewport Override did not update the mapping list.

• BUG ID 53743 - UI: Game input mapping shortcut changes were not saved when switching presets.

• BUG ID 53748 - Model: Using the Apply Morph tool to transfer the morph values from a relative to
an absolute morph created unexpected results.

• BUG ID 53766 - Volumes: VDBVoxel cache glitches occurred in the 3D viewport and Render view.

• BUG ID 53767 Render: Increasing the value of Spread Angle for a Directional Light caused specular
noise.

• BUG ID 53779 - Scripting: Deselecting edges after running a script that selected them was not
possible.

• BUG ID 53780 - Model: 2D overlapping edge selections often failed.

• BUG ID 53781 - File Input: Image viewer displayed tiled EXR aspect ratio incorrectly.

• BUG ID 53790 - Render: Scaling down a single mesh light axis made the light brighter.

• BUG ID 53792 - Network Rendering: Aborting a network render, using slaves only, caused incorrect
functionality and occasionally resulted in Modo crashing.

• BUG ID 53805 - Model layout: Collapsing edges, with edge weighting assigned to them, incorrectly
applied weighting to new vertices.

• BUG ID 53806 - Model layout: Edge weighting didn't propagate correctly when applying the Edge
Bevel and Polygon Bevel tools.

• BUG ID 53816 - Animation: Deleting an item in a scene, with an active Command Region, caused
Modo to crash.

• BUG ID 53817 GL: Image sequences used as a GL Background performed slowly.
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• BUG ID 53839 - Replicators: The viewport performance, with a scene containing a Replicator using
multiple prototypes, was slow in Modo.

• BUG ID 53844 - SDK: It was not possible to put geometry into setup mode when using a
CharacterBox kit script.

• BUG ID 53860 - Particles: Replicating items along a curve using the Curve Particle Generator created
alignment issues.

• BUG ID 53868 - Model layout: The polygon.make command did not work on Subdivs (1 or 2 FACE
Polygons).

• BUG ID 53893 - Model layout: Mirror merged vertices with hidden geometry.

• BUG ID 53897 - File Output: Exporting Selected Layers did not export Library shaders.

• BUG ID 53910 - GL: Hit testing on curves with transformed parent items was incorrect.

• BUG ID 53914 - UV: UV background images took significantly longer to display than in Modo 10.2.

• BUG ID 53925 - Render: Modo crashed when trying to render with a corrupt frame buffer file on
disk.

• BUG ID 53929 - GL: The Environment > Outdoor > Outdoor Spherical 02 preset did not display
after switching GL Background to Environment.

• BUG ID 53939 - UI: When a Locator with children was selected, clicking on another item's Delete
button presented a warning to delete the Locator.

• BUG ID 53954 - UI: Area Lights allowed setting negative size values when using the tool handles but
did not allow negative values set in the Properties pane.

• BUG ID 53955 - UI: With the Preferences > Display > Tool Handles > Draw Style option set to
Advanced and Edit > Show Dimensions enabled, incorrect values were displayed in the viewport.

• BUG ID 53967 - Shader Tree: Editing multiple selected groups of textures in the Shader Tree did not
work as expected.

• BUG ID 53971 - Model layout: The Symmetrize mesh operation did not work with a Morph Map.

• BUG ID 53993 - Preview: Preview did not always update when shaders were moved in the Shader
Tree.

• BUG ID 54007 - UI: Channel state randomly changed to edit mode.

• BUG ID 54012 - UI: Reopening the Edge Selection Set panel, after searching for a property that did
not exist, caused Modo to crash.

• BUG ID 54020 - Fusion: Modo performed slowly for a scene containing many MeshFusion items and
resulted in unnecessary updates.

• BUG ID 54034 - Model layout: The OpenSubdiv item caused Modo to crash when closing the scene.

• BUG ID 54037 - Model layout: Undoing an Element Falloff caused Modo to crash.

• BUG ID 54041 - UI: Read-only commands caused panels to size incorrectly.

• BUG ID 54046 - Windows only: Using Bake from Object to Render Outputs sometimes resulted in
bad buckets.
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• BUG ID 54046 - Render: Optimization for shadow rays caused artifacts in object-to-object baking.

• BUG ID 54054 - Color: Color Picker RGB (HDR) channels capped at 1.125 with Global Options >
Numeric CS set to the default sRGB colorspace.

• BUG ID 54056 - UI: The default Preference setting for the FBX Export File Format was not set to
Use Latest.

• BUG ID 54058 - Model layout: MeshFusion randomly failed to produce a mesh.

• BUG ID 54065 - Dynamics: The Dynamic Replicator Force options influenced Soft Body items.

• BUG ID 54067 - Render: Mesh smoothing caused the deferred shading samples to merge incorrectly
by the shading rate and caused longer render times.

• BUG ID 54077 - UI: The Opacity channel for the Morphed Mesh drawing option, Drawing Style to
Cage, was not limited to a 0 -1 range.

• BUG ID 54085 - UI: Changing System > Preferences > Date > Preset Markup Definitions types
sometimes caused Modo to crash.

• BUG ID 54090 - Shader Tree: Occlusion rays were fired regardless of material mask and caused
unnecessary calculations.

• BUG ID 54091 - Model layout: A MeshFusion scene produced an incorrect mesh after switching to
the output mode Airtight Final with Parts.

• BUG ID 54092 - Model layout: Applying a geometry Freeze on a mesh that had a displacement map
and Deformer caused Modo to crash.

• BUG ID 54093 - Procedurals: Deformers could not be disabled until their Effector was deselected.

• BUG ID 54096 - Model layout: Clone tools used with curves were not working as expected.

• BUG ID 54110 - Model layout: Align Work Plane to Selection did not work correctly with polygons
parallel to world axis.

• BUG ID 54114 - Deformers: Setting the Spline Deformer Number option to 2 caused Modo to crash.

• BUG ID 54120 - UV: Selecting the UV island by double-clicking in Polygon selection mode, when the
mesh was deformed or keyed was not possible.

• BUG ID 54132 - Preview: Volumetrics was reset in Preview after an Autosave.

• BUG ID 54133 - Shader Tree: Using the drag-and-drop action from the Shader Tree onto a mesh
caused Modo to crash.

• BUG ID 54140 - GL: When a viewport preset loaded from the config that was set to use the
Advanced viewport, the Advanced viewport was disabled.

• BUG ID 54143 - Scripting: Firing viewport.infoSub caused Modo to crash.

• BUG ID 54146 - Scripting: Adding a vertex in a script was not working.

• BUG ID 54148 - GL: Invisible inactive items caused the viewport navigation to not work as expected.

• BUG ID 54150 - Scripting: Querying view3dservice mouse.hitPos did not work unless the element
under the mouse was on a selected item.
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• BUG ID 54165 - Scripting: Recorded macros and Python scripts did not allow you to use several core
tools.

• BUG ID 54167 - Network Render: A network rendering function crashed during a bake border
expansion.

• BUG ID 54172 - Item List: Using the backspace key after selecting an item produced a Schematic
node removal error.

• BUG ID 54174 - UI: Remapping the mouse input preset to Maya or (Alt-LMB-MMB zoom) caused the
panel not to set the location/pinning state.

• BUG ID 54184 - Model layout: Setting the angle to 180 degrees on the Arc tool caused the geometry
to disappear.

• BUG ID 54199 - Dynamics: Dragging a Softbody into another scene caused Modo to crash.

• BUG ID 54206 - Model layout: The Vertex Map > Apply Morph option did not work as expected.

• BUG ID 54208 - Dynamics: The Procedural Shatter did not connect to the geometry and the solver
was missing.

• BUG ID 54214 - Render layout: Vertex Illumination Baking was broken for transformed items.

• BUG ID 54219 - UI: Renaming textures caused Modo to crash if a render item channel toggle was
displayed in the UI.

• BUG ID 54229 - Dynamics: Simulating at the current time with a specific scene caused Modo to
crash.

• BUG ID 54230 - Model layout: Drawing a tube in a mesh with procedural operators caused Modo to
crash.

• BUG ID 54240 - Item List: Removing tags did not mark the scene as changed and changes were lost
when closing the scene in Modo.

• BUG ID 54249 - Render layout: UV seams caused baking to break.

• BUG ID 54263 - Render layout: Portals did not work as expected.

• BUG ID 54274 - Procedurals: Curve Extrude polygons flipped when the sweep path was rotated.

• BUG ID 54276 - Render layout: Moving the render camera's target sometimes caused Modo to crash.

• BUG ID 54300 - Shader Tree: Copying multiple texture layers was not possible and the colors of a
pasted texture layer were not transferred.

• BUG ID 54301 - Mesh Types: Changing from an instance to a mesh did not respect multiple
selections.

• BUG ID 54345 - File Input: Reloading an auto-saved scene, when references were not auto-saved
caused Modo to crash.

• BUG ID 54353 - UV: Edge Bevel incorrectly created UVs in an empty UV map.

• BUG ID 54362 - UI: A corrupted customized config file was deleted rather than renamed.

• BUG ID 54379 - Preview: Preview did not output black values in the Alpha output when rays missed
the surface in Bake mode.
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• BUG ID 54386 - GL: Locking the Work Plane did not make it visible when the visibility was set to
active.

• BUG ID 54393 - UV: Setting the polygon type to Subdivs with UV Distortion enabled, caused Modo
to crash.

• BUG ID 54413 - File Input: Importing multiple SolidWorks files sometimes caused Modo to crash.

• BUG ID 54509 - Volumes: VDBVoxel did not load assets compressed with Blosc.

• BUG ID 54516 - Render layout: Render curves rendered black.

• BUG ID 54552 - File Output: Game Tools > Export failed when the material had an image in it.

• BUG ID 54556 - Deformers: Handles appeared in the incorrect location on deformed items.

• BUG ID 54566 - UI: Work Plane spelling was not consistent.

• BUG ID 54579 - Fusion: MeshFusion items were invisible when the 3D Viewport Properties >
Visibility > Show Locators option was disabled.

• BUG ID 54631 - Particles: Particle Look At Modifier Apply 0% incorrectly modified the incoming
particles.

• BUG ID 54639 - Performance: vertMap.applyMorph caused unnecessary procedural mesh
evaluation when selection changed.

• BUG ID 54647 - Model layout: Applying Edge Fill Quad and a fill with a grid pattern option produced
a 2 polys unsubdivided in a 3 x 1 polygon selection.

• BUG ID 54676 - Model layout: Reusing Select > Use Selection Set caused Modo to crash.

• BUG ID 54816 - Windows only: The DirectShow API framework failed to load an audio file and
caused Modo to crash.

• BUG ID 54825 - GL: PSub was corrupted when changing the subdivision level.

• BUG ID 54847 - Particles: The Curve Particle Generator incorrectly spaced particles.

• BUG ID 54860 - File Output: Exporting a mesh item parented to an instance item to .fbx caused
Modo to crash.

• BUG ID 54877 - File Input: The MDD reader did not close files and the handle count increased as you
moved around in the Timeline.

• BUG ID 54905 - Particles: The Point Count channel disappeared from the properties of the Curve
Particle Generator.

• BUG ID 54906 - Replicators: Replicator and Curve Particle Generator using bad geometry caused
Modo to crash.

• BUG ID 55009 - Volumes: Volume rendering with VDBVoxel items had clipping issues.

• BUG ID 55019 - Fusion: Moving meshes that are part of a MeshFusion item sometimes caused Modo
to crash.

• BUG ID 55123 - Scripting: Using a script to bake items in a scene sometimes caused Modo to crash.
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Developer Notes
Here are the changes relevant to developers.

Bug Fixes and Enhancements
• SDK: It was not possible to get a CLxUser_SchematicNode() interface from a Schematic item node.

• SDK: ILxSchematicNodeConnection has been replaced with ILxSchematicNodeChannel in the
Schematic SDK.
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